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Description 

A key component of the Revit workflow, systems define the relationship between HVAC, piping 
and electrical components, but also provide alignment with critical data that helps progress 
design models towards a true digital twin. In this session, we begin by reviewing the analytical 
systems that help to define the hierarchy of a system. Next, we cover the four-step process that 
creates the relationship between target and source devices and helps with the creation of 
connecting geometry. We also examine best practices for system families to prevent model 
issues and wrap up with ways to collect and share data with external sources. This session 
concurrently covers air/fluid/electrical systems in a way to help you understand making your 
systems work consistently and correctly. 
 
Speaker(s) 

David Butts is an Autodesk Expert Elite Team member and Engineering Technology Manager 
for Gannett Fleming with over 37 years of experience in the architecture, engineering, and 
construction field. He is responsible for implementation, training, BIM\PIM project support, and 
management for engineering design applications, including Revit, AutoCAD Plant 3D, AutoCAD 
MEP, Navisworks software, and more. He was an Autodesk Authorized Training Center (ATC) 
training manager and application engineer for an Autodesk Reseller for 13 years, providing 
implementation and training services across the United States, and serving as a Subject Matter 
Expert for Autodesk, engineering software, training and certification programs. He has design 
experience for a variety of project types, and he was an Autodesk University top-rated speaker 
for labs and lectures in 2011, 2016 and 2019. 
 
 
 

 

Learning Objectives 

 Reviewing HVAC /Piping/Electrical Analytical Systems in a Revit project 
 Understanding the Four-Step Process and Workflows for HVAC, Piping and 

Electrical Systems and Circuits 
 Evaluate Engineering Component Families for best system performance and data 

management 
 Examine Guidelines for Sharing MEP Data for System Analytics and with External 

Resources 
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Introduction 

 
It’s hard to believe that a mere two decades ago, that Autodesk acquired the Revit Technology 
Corporation. As it is with most technology, it has evolved rapidly from Leonid Raiz and Irwin 
Jungreis’ vision of a parametric modeling program that could be used to model architectural 
projects. The progression of engineering tools within the program has reached a new 
technology chasm, which represents a shift from a generation’s 2D project approach to a true 
3D, digital twin workflow. 
 
The systems within Revit MEP are a great representation of the progress that has been made. 
While originally intended to help duct, pipe and electrical systems connected and help create 
layouts between the modeled components, we are now beginning the process of defining the 
relationship between the schematic and physical. The concept is not new, but the workflow for 
the MEP industry is – to walk away from the drafting tool and begin to build out the complete 
system in a Revit model. 
 
I had a chance to talk to Martin Schmid, product manager for Revit MEP, who has been a great 
friend and colleague over the past several years. After I started working with the new analytical 
tools, I asked him to explain the intent and direction for where he believes they are going (be 
aware, this quote includes forward looking statements, which may or may not actually result in 
changes to the program): 
 
“Whether mechanical or electrical, the analytical concepts define the requirements of the 
system.  Everything downstream is contingent on the concept/analytical model.  Whether it’s 
schematic or physical, the concept exists throughout the life of the project, and the analytical 
model defines the core data structure and relationships, if you will.  It’s what is common to both 
representations and serves as a source of truth. 
  
Contrast to how Revit is used today, e.g., someone creates a physical model, and needs to 
make sure the pipe is the right ‘system’. Depending on how modelers end up connecting things 
(or not) the logical representation of systems in Revit may or may not be in a good shape. 
System Browser ends up being something that needs to be managed if you want to leverage 
the logic/hierarchy. Instead of there being an analytical construct that is maintained that is 
defined by the system concept (which is either in the engineer’s head, on a ‘dumb’ 2D drawing, 
or in some other tool that may or may not be able to share data with Revit, or some combination 
of all these).   
  
Similarly, even before one is ready to model conduit, and conductors, they have a pretty good 
idea about what conductor/conduit sizes & requirements are going to be. An engineer not using 
Revit can create their feeder schedule without having to route from point a to point b in 3D 
space. This is why one of the items on the Revit Roadmap is Analytical Conductors.  What the 
3D model helps ‘fine tune’ is getting an accurate length to validate if voltage drop will be an 
issue and facilitate up-sizing accordingly.   
  
Thus, the analytical model capabilities serve as a foundation to build on to capture and maintain 
requirements to ensure that the resulting physical model can be validated against the system 
concept (and in a pie in the sky vision, be used to generate the physical), and not just a 
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collection of elements in 3D space that may or may not form a holistic view of the MEP Systems 
they are intended to represent.” 
 
So where does this take us? The importance of well-formed systems in Revit is critical to a 
successful project – but there are more factors that influence systems that just creating the 
connection. A thorough understanding of all of the components – from the creation of the 
analytical system to the final data associated with elements – is critical to achieving this 
success. Let’s take a journey through all of these features, and help you perfect your system in 
Revit. 
 
By the way, for those trying to keep up with Revit development, please check out the Revit 
Public Roadmap in Trello: 
 
Revit Public Roadmap | Trello 
 
 
 
 
Important Note: This document uses images that reflect parameters and configurations that 
were defined in a corporate standard template used by Autodesk and Gannett Fleming. Not all 
parameters that appear in the properties dialog, or the families used in the example, will appear 
or be available in your content, or in out-of-the-box Autodesk templates and content. 
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Reviewing HVAC//Piping/Electrical Analytical Systems 

 
The Systems Browser tool allows users to see all place equipment and connected systems in a 
Revit project model. Recent releases add HVAC and electrical systems to the project database, 
and Revit 2023 expands the use of these systems for a variety of purposes: 
 
- HVAC analytical systems identify the zone equipment, air systems, water loops and 

systems-zones that are to be created in a model. 
- Analytical Power Distribution systems identify power sources, busses, transformers, 

transfer switches, and equipment load.  
 
The best way to describe the intent and use of these components are equipment lists, that 
include all of the MEP components that could be used in a project. Similar to how HVAC flow 
diagram or electrical power one line are created, these items are added in table form instead of 
the traditional graphical “schematic view”. The System Browser becomes the interface to 
visualize these relationships. 
 
Before getting too far into the details, we need to jump ahead to an explanation of systems 
within Revit. One of the key tenents of MEP design we have taught has been the “Four Step 
Process” (which we go into greater detail in the next section). The first step, identify and add 
equipment, includes the explanation of targets and sources. In order to understand the 
analytical system, you have to understand the role of target and source equipment. 
 
Targets are typically “end of line” components that define systems when creating the physical 
model representations. Targets are easily identified as any device that receives air/fluid/power 
in a system. This includes: 
 
- Electrical Receptacles, Lights, Disconnect Switches 
- Air Terminals, Terminal Units 
- Tanks, Pumps, Plumbing Fixtures, Sprinklers and Outlets 
 
Multiple targets make up a system, and control the assigned load and sizing values within a 
system, 
 
Sources are “beginning of line” components that accumulate data from targets within a system. 
Only one source (equipment) is included in a system, and it controls the flow of air/fluid/power to 
targets. Source equipment includes: 
 
- Power Panels, Switchgear, Power Source 
- Air Handling Units, Condensers, Fans, Terminal Units 
- Tanks, Pumps, Water Heaters and Fire connections 
 
Let’s begin by taking a look at the HVAC analytical system. 
  



 
 

 

 

Page 5 

Creating the HVAC Analytical System 
 
The HVAC Analytical System is made up of four components: 
 

- Air Systems – primary air handling systems for the building/structure 
- Water Loops – primary water systems for cooling and heating fluids for an air handling 

system 
- Zone Equipment – specific air handling equipment that provides service to unique 

system zones 
- System Zones – areas within a building/structure associated with Spaces to collect 

HVAC data and use for systems analysis 
 
Air systems and water loops are added first, with the zone equipment added afterwards for 
each. Once the zone equipment is added it can be associated with an air system, water loop 
and system-zone for HVAC analysis. One key note: make sure you edit the name of each 
device as they are added to help keep the organization of the systems clearly defined. 
 

Adding the Air System 
 
Air systems in an HVAC analytical system represent the end point of an HVAC system and is 
typically represent by an air handling unit or similar component.  

1. The system is added from the system browser, Add Air System tool: 

 

 
 

2. Once the air system is placed, review the properties palette and set types of 
subcomponents within the system, including heat exchangers and coils. Select the Fan 
type to complete the step. 
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3. If fluid-based coils are selected, the option to select the water loop equipment is 
displayed. This can be modified after the loop has been defined - if a loop already exists, 
select it. 

 
 

Adding the Water Loop 
 
Water loops in an HVAC analytical system represent the fluid components in an HVAC system 
and are typically represented by cooling or heating coils.  

1. The loop is added from the system browser, Add Water Loop tool: 
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2. Once the water loop is placed, review the properties palette and select a loop type: 

 

 

 

3. If a chilled water or variable refrigerant flow (VRF) system is selected, you can select the 
chiller type: 
 

 
 

* Note the warning triangle no longer appears on the water loop icon as the loop settings 
are now complete. 

 

4. Return to the Air System and select the Water Loop type to complete this step: 
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Once air systems and water loops are added, the next step is to add zone equipment. 
 
 

Adding Zone Equipment 
 
Zone Equipment in an HVAC analytical system represents system equipment below the 
primary unit in an HVAC system, and are typically represented by terminal units, VAV boxes, 
and other similar intermediate equipment. These devices can take on the characteristic of being 
both a target and source.  

1. The equipment is added from the system browser, Add Zone equipment tool: 

 

 
 

2. Once the equipment is placed, review the properties palette and select the equipment 
type: 
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There are several primary options. Selecting the type determines the available sub-components 
that can be chosen, as well as associate the equipment with an air system or water loop, 
depending on the system configuration. For example, the Variable Air Volume (VAV) Box 
adds selections for behavior, heating coil, air system and draw ventilation: 

 

 

 

Once the zone equipment is defined and associated with the relevant air system and water loop 
(where applicable), you are now ready to associate it with system zone. 
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Adding System Zones 
 

Autodesk has “retired” several older tools, including HVAC Zones, that were used with prior 
heating and cooling load tools, and replaced them with the System-Zone. This newer tool allows 
a user to quickly select predefined spaces in an MEP model, and gather their type, load, 
schedule, volume, area and other critical data to use in a load analysis. While this class does 
not go into detail about the analysis, it is critical to understand how the new HVAC analytical 
systems are now used in conjunction with these tools. 

 

1. When creating a system zone, make sure you have spaces properly defined in a model, 
and visible in a view. Place a system zone by selecting the tool from the Analyze tab, 
Energy Optimization panel: 
 

 
 

2. After selecting the tool, you can use the linework tools to indicate which spaces are to be 
included. Be aware that spaces do not need to be adjacent to each other to be included 
in a zone: 
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3. The linework must “intersect” a space in order for it to be included. Be aware that a 
space can only be associated with one system zone. For larger areas, use the space 
separation tool to break these up into smaller spaces.  

4. While the tool is still active, review the properties. It is critical to name the system zone 
as early as possible – change it to accurately match the area, rooms or spaces included. 
You can also select the zone equipment at this point as well: 
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5. Select the green check mark to complete the task. 
6. Review the air system in the system browser to make sure the model is complete, with 

no warning symbols. 
 

After completing this step, you use this same workflow to continue to add and associate air 
systems, water loops, zone equipment and system-zones until all areas are accounted for. Be 
aware that in order to create a well-formed HVAC load and energy analysis, you must complete 
these steps first. 

* Be aware that the Energy Model should be created after all system zones and analytical 
systems are created. In some cases, analytical spaces will not correctly associate with zone 
equipment. If this occurs, delete the energy model and then re-create it: 

 

  



 
 

 

 

Page 13 

Creating the Analytical Power Distribution System 
 
The Analytical Power Distribution System is made up of five components: 
 

- Power Source – utility or generator connection 
- Bus – primary distribution component such as panel, switchboard, MCC, etc. 
- Transformer – power transformation device 
- Transfer Switch – power control device that can be supplied by more than one power 

source 
- Equipment Loads – specific load value from single source (disconnect, equipment, etc.) 

or multiple source (branch circuit for lights, receptacles, etc.) 
 
The analytical power source is added first, followed by key analytical bus equipment. 
Transformers are added to allow voltage changes where relevant, and transfer switches are 
placed to control power from one to two sources. Equipment loads from a generic standpoint 
are added as individuals loads, similar to devices added to an electrical riser diagram.  
 
One important note: make sure you edit the name of each device as they are added to help 
keep the organization of the systems clearly defined. 
 

Adding the Power Source 
 

The first step is to add the power source, which represents the primary connection point, meter 
or generator.  

1. Select the Add Electrical Analytical Power Source from the System Browser: 
 

 
 

2. When creating the source, make sure it is named and associated with the correct 
workset. Review the electrical circuiting information to make sure it is appropriately 
assigned: 
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3. If a backup generator is included, go ahead and add it as a power source: 
 

 
 

4. Once all power sources are placed, you can move on to other components. 

 

Adding a Transfer Switch 
 

The transfer switch can be placed at any point in the workflow, but we’re adding it here in order 
to establish the connection path from power sources to other devices, such as a conceptual 
bus. 

 

1. Select the Add Electrical Analytical Transfer Switch: 
 

 
 

2. Rename the switch as needed. Change the Supply from 1 to the Utility Connection, and 
Supply from 2 to the Backup Generator. This completes the association: 
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3. Note how the transfer switch now appears as a device directly below the power source, 
correctly defining the relationship between these devices. 

4. Next, we can begin to add the bus equipment. 

 

Adding the Bus Equipment 
 

Bus Equipment is a general term that describes the primary conceptual source equipment in a 
Revit system. This can include panels, switchgear, motor control centers and busways. 

 

1. Select the Add Electrical Analytical Bus: 
 

 
 

2. As devices are placed, initially they will appear under the Unconnected section of the 
system browser until they are assigned to a power source or transfer switch. In this 
example, the first analytical bus device added is a switchboard, identified as SWB-1, and 
supplied from the transfer switch: 
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3. Next, select the analytical bus tool to add a device under the switchboard to represent a 
main distribution panel. In this, it is identified as MDP1: 
 

 
 

4. You can continue to add bus equipment as needed, but the logical relationship between 
devices is clearly defined. 
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Adding a Transformer 

 
In Revit electrical systems, in order for load to be passed between higher and lower voltages, a 
transformer is required to be assigned to the system. This is true for both analytical and actual 
power systems in order to work correctly. 

1. When adding transformers and equipment loads, select the power source the equipment 
is to be associated with, and select the Add Electrical Analytical Transformer: 
 

 
 

2. After adding the transformer, edit the name and select the “Supply from” option to set the 
device (if not selected before). 
 
 

 
 
After placing the transformer, you can now begin to add equipment loads. 
 

Adding Equipment Loads 

 
In Revit electrical systems, equipment represents the “target”, or item that receives electrical 
current. Equipment loads are represented by lights, receptables, equipment, disconnects and 
other end of line devices.  

1. When adding equipment loads, select the power source the equipment is to be 
associated with, and select the Add Electrical Analytical Equipment Load: 
 

 
 

2. After adding the equipment make sure you edit the name, voltage and current rating: 
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3. You can continue to add devices to the bus equipment – for example, you can define an 
equipment load that represents the lighting fixture circuit. When the load is assigned 
along with the load classification, the load will be reflected upstream from the devices: 
 
 

 
 
One key item to note – Revit is not an engineer, and currently doesn’t distinguish 
between good design practices and workflows. For example, this image indicates that 
two power distribution panels are connected to one transformer. While this could occur 
with a feed through lug configuration, it still is not correctly defined. It’s dependent on the 
user to make sure they are correctly defining the relationships. 
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Creating Area Loads 
 
The last feature we are covering for analytical features are the electrical area loads. Intended as 
an early review of potential load requirements, it allows a user to define a 3D block that 
incorporates spaces. 
 

1. From a plan view, Analyze tab, Electrical Analysis Panel, select the Area Based Load 
Boundary: 
 

 
 

2. Use the rectangular boundary tool to create a “box” around the building area – you can 
also use lines, arcs, circles or the tab selection tool to use the geometry in the view and 
create the boundary: 
 

 
 

3. When creating the boundary, be aware that this is a 3D shape you are creating – select 
the top level (in this case, the roof above the second floor) while defining the boundary. 

4. Once this is completed, click Modify to exit the command and complete this step. Next, 
select the Area Based Loads tool, and a new ribbon/properties dialog will appear: 
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5. Begin by reviewing the properties, and select the Area Based Load Type: 
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6. Select the New option in the lower left corner to create the load type – in this case, we 
are using a description, “Medical Office” to describe the area: 
 

 
 

7. After creating the load area, review the remaining properties – define a name for the 
load area, and select the Electrical Analytical Bus from the list of devices created in 
our previous steps.  
 

 
 

8. Note that the loads and area are shown – as equipment loads are added to the system 
and areas, the data will update for each area.  
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9. Select the load area to select all of the spaces within the area. Once the load area is 
assigned, the estimated loads are populated: 
 

 

 

10. The last step is to associate the equipment load with the area load. While the area load 
is selected, click the Equipment Load tool from the Analyze tab. On the options bar, 
select the power source for the area load – at any time, you can return to this option 
and change or edit the relationship between the area load and the device that feeds it – 
this will in turn update the System browser to reflect the area load associated with the 
power source. 

 

Now that you have defined HVAC and power distribution systems, let’s move on to the design 
modeling process. 
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Understanding the Four-Step Process and Workflows for HVAC, Piping and 
Electrical Systems and Circuits 

 

The methods used by engineers and designers to create HVAC, plumbing, piping and electrical 
systems has not changed since the days of hand drawing, other than the improvements to 
equipment. While the introduction of analytical systems helps us begin to pull all of the data into 
a single location, the workflow for creating these systems is still the same. The work process 
follows a straightforward approach, where the building requirements are assessed first. The 
necessary equipment types are selected and located, and then the connecting components, 
such as duct, pipe and wiring are added.  
 
Once these are added, critical data and directions are provided in the construction documents in 
the form of specifications, schedules, and annotations on drawings that identify and label the 
components. While there are occasional points where you step outside of the process (such as 
locating critical duct/pipe items in a chase), the process stays the same. 
 
Using Revit for MEP design works best when you implement a four-step process that emulates 
this approach. By following the same repeatable process, you can get more efficient at 
completing our projects on time and under budget. The primary steps are: 
 

 Select and Locate Equipment – the targets and sources that define a system; 
 Define and Refine the System – creating the system that connects the equipment 

together; 
 Connecting Geometry – adding the ducts, pipe, conduit, cable tray and wire; 
 Annotating the Model – adding tags, schedules and other annotations in views for the 

construction documents. 
 
The logic in this approach is to create a consistent method of approaching work. The second 
step, defining the system, is a task they typically is not accounted for in most projects budgets, 
since it was not required for plain AutoCAD or AutoCAD MEP.  
 
The system is what links the sources, which are the end-of-line equipment that provide air, fluid 
and power to the targets. The targets include items such as air terminals, motors, sinks, and 
more, and are what is used to define the system. These items are usually placed at the same 
time as the primary equipment, after the overall assessment of the building needs are 
determined. 
 
Let’s start by taking a look at how these systems are defined. 
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Placing Equipment 
 
The first step is always to place any equipment you are using into the model. In the analytical 
systems section, we create the predefined “equipment” list of primary components that make up 
a system. In our first section, we described what defines the equipment, including targets and 
sources. 
 
The key point for this section is that systems do NOT require that you place all equipment prior 
to creating the system – but what are the key points you need to be aware of to complete this 
first step? 
 

- The equipment must have MEP connectors included and assigned. Be aware that the 
connections should be located in the host model if you are using nested families. While it 
is possible to use some connections, it is not recommended. The host correctly exposes 
these connections to allow for proper system definition. 

- Check your elevations! For someone moving from 2D to 3D, understand the location of 
the connection in the vertical plane is critical, so connecting devices can be properly 
routed. It’s a good idea to have plan and section view open at the same time so you can 
see where devices are being placed relative to the level. 

- While you may have families that are “hosted” versus “non-hosted” be aware that all 
families have a host. With a family that is not based on a workplane, face or other 
surface, they are still hosted to the level they are placed on, such as a first floor. 

- Be aware of your environment – make sure you have the correct worksets active, the 
visibility graphics defined so you can see the equipment, and the view range clearly 
defined so the equipment will be visible in this “horizontal slice” that is a floor plan view. 

- Connecting geometry such as duct, pipe, conduit and cable tray should NOT be the 
priority at this point. Without placing the equipment first (and defining the system to take 
advantage of sizing tools), routing area requirements are based on speculation and not 
on the actual placement of these components. 

- Use placeholders for early layout and design if you don’t have specific and clear 
direction on the actual equipment. Equipment can be replaced as needed later in the 
project. For example, on most projects, lights and air terminals can be based on minimal 
level of development as opposed to specific manufacturer representations – which in 
turn can add more detail that is required for the project. Review your Level of 
Development requirements for the project and be aware of these rules before placing 
your equipment. 

 
Creation of the system always follows the placement of objects. Here are two examples for how 
to create the equipment needed for an HVAC system and an Electrical system. 
 

Adding HVAC Equipment 
 
In this example, we will place a series of air terminals and a VAV box as the target and source 
examples. 
 

1. From an HVAC Second floor plan view, make sure you have family examples loaded 
into the project. This example is using out-of-the-box families to simplify the steps. 
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2. From the HVAC Second floor plan, place the air terminals around the room.  
 

 
 

3. You can also do this from a reflected ceiling plan – be aware that if you are using hosted 
families, that you are selecting the ceiling grid. Some hosted families like air terminals, 
when hosted with a level, will actually be placed upside down, with the connector pointed 
down instead of up. Check this by using a section view: 
 

 
 

4. Next, add a VAV box to the area. This example has its elevation based on the centerline 
of the supply connector: 
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5. In this case, the air terminals represent the targets for the system, and the VAV box is 
the source.  
 

Now that the diffusers are placed, let’s review the lights and panels. 
 
 

Adding Light Fixtures and Panels 
 
In order to create the circuits, you must have electrical or lighting fixtures placed, and electrical 
equipment including panels, transformers and other devices need to control the flow of electrical 
power in a model. Begin by opening Second Floor Electrical plan.  
 
1. Some light fixtures have been placed in the view – select one and review the properties: 
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2. This is an example of a non-hosted light, with an elevation set to 9’. You can change 
these properties quickly as needed to adjust for ceiling heights, but the same rules apply 
as the air terminals – if you are using a hosted light and are trying to associate with a 
ceiling in the architectural model, use a section to check the orientation. The light source 
must be pointing into the space in order to be correctly associated with the light loads for 
the space. 

3. Here’s a quick trick – once one example is placed, use a selection window and filter 
tool to select only the lights in a specific area, such as the corridor: 
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4. You can remove any items you don’t want in the selection set. Next click OK, and then 
click Copy from the Modify tab. Duplicate the lights on the other side of the corridor: 

 

 
 
5. The same properties associated with the first type will also be included in the copies, so 

you only need to make this change once. To check the load values, select a light and 
then edit the Type (there’s a lot here that will take up the entire page): 
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Examples of type-based Shared 
Parameters used in schedules 
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6. Since type properties cover all examples, the data is easier to “spread” to other fixtures, 
with minimal changes. Different light types, for size, voltage, special conditions, and 
lighting photometrics, can all be including in a single family, greatly reducing the size of 
your library while providing the same value. 

7. For the source equipment, open the Ground Floor Electrical view and review the 
panels that have been placed in the electrical room: 

 

 
 
8. These represent a stepped up voltage system, where LP1 represents a 120/208v 

system. T1 represents the transformer, and MDP represents the higher voltage main 
distribution panel for 277/480v circuits and equipment. Select a panel to review the 
properties: 
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9. This represents some of the critical data that the panel tracks – including the connected 
load, circuit properties, mounting and name parameters the circuit needs in order to be 
defined. Without the panel or other electrical equipment, the data is not tabulated 
completely until the system relationship is defined. 
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Creating the Target Source Relationship 
 

MEP systems in Revit boil down to a simple task. A relationship, which is defined by a target, is 
established be creating a connection to a source. In traditional CAD documentation, it’s 
demonstrated by following the routing of duct or pipe between these items. But after the building 
is finished, after the slab is poured, the ceilings and wall finishes in place, and the roof topping 
the building how, most of these items remain invisible to the occupant. 

In Revit, they’re never invisible. This relationship can be made by either routing the duct and 
pipe or by simply using the system tools to create it. There are several key advantages for using 
the system tools first: 

 The best indicator is the tab selection tool, which allows the user to place their cursor 
over a device, tap the tab key, and see the structure of the system. 

 The system can be used for simple layouts, based on preset preferences for materials 
and routing elevations. 

 The system can also be used to control visibility properties throughout a project, 
based on system type settings or view filters. 

 You can select several targets at once and use them to define a system – for example, 
selecting several air terminals that will all belong to the same system saves several 
steps. 

 The system tracks the load data from the target devices back to the sources, exposing 
overall system data. But a source is not always required…for example, plumbing 
systems may not require a source to be defined. 

 

Defining the System by Target 

To create a system in Revit, select any one of these devices: 

 

 

target: air terminal – duct system 

 



 
 

 

 

Page 33 

 

target: pump – power system/piping system with multiple connections 

 

 

target: plumbing fixture – source not required (i.e., waste, for a variety of reasons) 

 

In all cases, the system is defined by the connector, the role the part plays in the system and 
the defined Revit family category. 

1. To create the system, you simply choose the system type from the ribbon. If a part has 
more than one connection, such as with the sink, you may be prompted to select the 
connector and system type (in this case, piping): 
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2. You would also be prompted to specify a system name, which helps you identify the 
system in the project. 

 

Duct Systems Defined 
 

Once you select the HVAC component that contains the duct connector, selecting the Duct 
system causes the Create Duct System dialog to appear: 

 

 

 

1. When only option, such as Supply Air, is available, it’s because the connector has a 
preassigned system classification – in this case, Supply Air. If multiple Supply Air 
systems are listed, it’s because you may have more than one Supply Air duct system 
defined – but only systems that are tied to the Supply Air classification can be used. 
 
The only time you will see all system types appear is when the connector is set to Global 
or Other. 
 

2. Here’s an important note: NAME YOUR SYSTEM. This will help you clearly identify what 
the target is servicing – such as the OFFICE 5 SUPPLY AIR system name. 

3. Selecting Edit System will open the entire set of system tools. The tool appears on the 
Modify | Duct Systems tab of the ribbon: 
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4. This tool allows you to review the properties, add/remove targets that define the system, 
and select the Source Equipment:   
 

 
Edit Duct System Tab 
 
Keep in mind – you can select any target that has been defined to a system after it has 
been defined, but you will get two context sensitive modify tabs: 
 

 

 

5. Modify Air Terminals will you get you the Edit Family, Fabrication and Layout and 
Analysis tools, while Duct Systems will display the tools for editing the duct system. 
 
Make sure you are selecting the right tab based on the changes you are making! 
 

6. The Edit Duct System (or Edit System) tool, located on the Duct Systems tab, opens 
the system up for editing. This tool allows you to: 

a. Review and set system properties such as the system name, image and 
comments that can be used in a schedule, and edit the system Type, which 
controls the graphic overrides, materials, calculations, identity data and rise drop 
symbols. 

b. Add other targets to the system (the system type must match). 

c. Remove targets from the system. 
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d. Select the Source Equipment from a drop-down list or by selecting the 
equipment family in the model view.  

e. See the number of elements that are included in the system. 

f. Finish and Cancel editing the system – note that you HAVE to close this tool by 
selecting one of the options before moving on to another task. 

 

Pipe Systems Defined 
 

Similar to the duct systems, you select the equipment component that contains the pipe 
connector, and selecting the system makes the Create Pipe System dialog appear: 

 

1. In this case, the connector is set to global, so you can select any system type or 
classification. Keep in mind that once the connector is set to a specific system 
classification, only system types in the same classification can be used. 
 
As with duct, make sure NAME YOUR SYSTEM to clearly identify what it is servicing.  
 

2. Selecting Open in System Editor will open the entire set of system tools.  
3. In some cases, if you have more than one connector assigned to the same system 

classification, you will be prompted to select a connector – all unconnected 
connectors will appear in the list: 
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4. Select the connector you wish to use, and then click OK. 
5. Once the connection is selected, select the Piping Systems tab of the ribbon: 

 

 
Pipe System Tab 
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6. This tool allows you to: 

a. Edit the system, which opens a new ribbon that allows you to review and set 
system properties such as the system name, image and comments that can be 
used in a schedule, and edit the system Type, which controls the graphic 
overrides, materials, calculations, fluid mechanical properties, identity data and 
rise drop symbols. 

b. Add other targets to the system (the system type must match). 

c. Remove targets from the system. 

d. Select the Source Equipment from a drop-down list or by selecting the 
equipment family in the model view.  

e. See the number of elements that are included in the system. 

f. Finish and Cancel editing the system – note that you HAVE to close this tool by 
selecting one of the options before moving on to another task. 

 

Keep in mind – you can select any target that has been defined to a system after it has been 
defined, but you will get two modify tabs: 

 

Modify Mechanical Equipment will you get you the Edit Family, Fabrication, Analytical 
Connections, Connect Into, and additional systems based on the connectors included in the 
family (if additional connections are available), while the Piping Systems tab will display to the 
right as shown previously - Make sure you are selecting the right tab based on the changes you 
are making! 
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Electrical Systems Defined 

 
Electrical circuits have similar behavior to piping and duct systems. When associated with a 
system, the target defines the load associated with the system. In order to have a well-formed 
circuit, an electrical panel or other type of electrical equipment must be defined as the source. 
When defining the circuit, the place to start is with the target.  

 

1. Using a selection window (and filters if needed), select all of the lights in a room: 

 

 

 

2. From the ribbon, Modify | Lighting Fixtures tab, Create Systems panel, click Power: 

 

 

 

3. The Modify | Electrical Circuits tab will appear: 
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4. From the Modify | Electrical Circuits tab, select the Panel drop down and select panel 
an available panel: 
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Note that the panel may be pre-populated, selecting the last panel used. Once the first panel is 
selected, as long as the circuit’s voltage settings match, the next available slot in the panel will 
be used. The circuit will now be assigned and can be changed as needed from the panel 
schedule. 

 

5. From the Modify | Electrical Circuits tab, select the Edit Circuit tool – the Edit Circuit 
tab will appear: 

 

 

 

6. If the type of connection is another panel, you can change the option from Breaker to 
Feed Through Lug, which is used for a panel-to-panel connection. Since light fixtures 
are typically specific to a circuit, leave this set to Breaker. 

7. In the properties palette, note the Load Name. This is derived from the location of the 
devices, based on the Space Name and Number. In the event a space is not found, the 
Load Classification assigned to the lights is used. The name can also include both 
(and can be edited as needed): 

 

 

8. For Wire Type, change this value to THHN to use a pre-defined wiring type, which will 
set the wire sizes based on the load, voltage drop and other values: 
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Note the wire sizes and number of wires assigned. 

 

The circuit is defined, and you can make changes to the families and layout as needed. 
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Creating Connecting Geometry 
 

Once the systems are defined, you can leverage these relationships to help add connecting 
geometry. In this section, we will review how to generate a duct layout for a defined system and 
leverage a circuit to create wiring layouts. 

 

Generating a Duct Layout 
 

After the system is defined, you can use the Generate layout tool to route duct based on MEP 
settings. Before routing the duct, go to the Manage tab and select MEP settings. 

1. Under Mechanical settings, select Conversion – this sets the default value for main 
and branch duct types and elevations: 
 

 
 

2. To check this, select a duct connection on the source device – use this elevation to set 
the elevation of the main, which uses the centerline elevation value. 
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3. After validating the settings, select any component within the system such as an air 
terminal, and check the Modify> Duct Systems tab. You can also use the Tab selection 
option 
 

 
 

4. Select Generate Layout:  
 

 
 

5. A series of options based on network, perimeter and intersection layouts appear, with 
mains indicated by blue lines while branches are indicated in green. You can also select 
Edit Layout to make modifications to positions and alignments of the duct. 
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6. Select an option to complete the step. Provided there is enough space to place fittings, 
the layout will be completed – any errors will be indicated as warnings. 
 

 
 
This is an example of how to leverage the system relationship to reduce manual tasks to 
generate the ducts. Next, let’s review how to accomplish the same when adding wiring to 
a view. 

 

 
  



 
 

 

 

Page 46 

Generating a Wiring Layout 
 
While duct and pipe are created in a Revit model as a physical representation of an object using 
the actual size and dimensions, wiring is represented by schematic linework instead that is 
specific to the view. In this example, we can quickly create a wiring layout using the electrical 
circuit. 
 
1. From an electrical view, review the lighting layout. If you want the layout to include any 

other devices such as light switches or junction boxes, add them to the view. From the 
project browser, you can select a light switch type and drag it into a view to include it in 
the layout.  

 
2. Next, define the circuit if one has not been created. You can do this quickly by selecting 

both the lights and switch – but if the circuit is already defined, use the Edit Circuit tool 
from the Modify > Electrical Circuits tab: 

 

 
 
3. Immediately after the circuit is defined, two options appear that allow you to add either 

an arc or chamfered shape wire – select arc as an example.  
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4. Note how the layout was automatically created. Review the properties to help 
understand what tasks remain to be completed – for this example, the circuit remains to 
be defined. Select one of the devices on the circuit, and then from the Electrical 
Circuits tab, select the panel. Be aware that if you have already created circuits, Revit 
will automatically go to the last panel used to define a circuit, but if one has not been 
defined, you will be prompted to select a panel. Change this from None to a defined 
panel: 
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5. If the circuit is defined before the wiring is added, a home run wire will also be included 
(and actually point in the direction of the panel, even if it is on a different level). You can 
manually add the home run wire by using the Wire tool: 

 

 
 
6. After the wire is created, the properties will reflect the changes to conductors, circuit 

name and number, load name and more.  
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Annotate! 
 
Traditional design practices have included the placement of text to describe an element in a 
drawing, but with today’s Revit annotation tools…just NO. Start with tags first – these annotation 
objects are associated with data that is included in the component or system family’s properties. 
If the component is changed the tag is updated – and if the properties in the tag are changed, 
they are pushed back to the component. While dimension and text can still be added to a view 
where applicable, get in the habit of using tags first for any component related information. 
 

Tagging Components 
 

Start by reviewing an HVAC plan view. The methods we use here will be the same for lighting, 
power, plumbing and piping documents. In this example, space name and numbers have 
already been added as tags, so now it’s time to annotate the air terminals.  

1. From the view, select one of the air terminals. After it’s selected, right-click to get the 
context sensitive menu that includes so many powerful options – click Select All 
Instances > Visible in View: 
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2. To label all of the terminals at once, select the Tag All tool from the Annotate Tab > 
Tag panel. The Tag All Not Tagged dialog will appear – select the Air Terminal tags. 
As long as a tag family has been added to the project, this option will be available: 
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3. You can choose to add a leader from the bottom of the dialog, but in this example this 
option is not selected, so the tags will be placed directly on top of the terminals (on 
purpose!). Click OK to complete this step: 
 

 
4. This example helps display what happens when you do not populate the data before 

placing the tag – but it also helps us understand that we still have tasks that need to be 
completed, such as assigning the type mark, air flow and other properties required by 
the tag. 
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Before completing that step, let’s review how to consistently place and move tags to 
have them all appear in the same relative location. Select a tag, and then use the same 
Select All instances tool to select the tags: 

 

 
 

5. After selecting all of the tags, use the Move tool to move them to the upper left corner of 
the air terminal. After selecting the beginning and end points, the tags are all consistently 
moved to the same location: 

 

 

 



 
 

 

 

Page 53 

6. You can now double click on a tag or select an element to edit its properties. This 
example includes the type mark and air flow value of the air terminal that applies to all 
examples: 

 

 

 

7. Make this change and the tags will update immediately with the new information: 
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8. You still need to edit the flow value, which is currently set to 0. You can edit individual 
terminals one at a time, or select all instances/select individual instances and change the 
flow value from properties or the options bar: 

 

 
 
These are great examples of the multiple uses of data from a single source, where one 
change this is made can update several other components and features within a model. 
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Evaluating Engineering Component Families 

 

What really makes a system tick? Beyond being a sum of all parts, the system relies on well 
formed, correctly defined component families. The MEP Connector is what separates 
engineering families from all other types of parts and understanding the role of the connector in 
systems is one of the most important aspects of Revit systems. In this section, we will examine 
how the connector defines the target-source relationship, and how to correctly associate data 
and parameters with connector properties. 

 

What is Flow? 
 

 
“Flow.” Merriam-Webster.com Dictionary, Merriam-Webster, https://www.merriam-webster.com/dictionary/flow.  
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A more detailed and apt description of flow includes: 

 

Definition of flow (Entry 2 of 2) 

1: an act of flowing 

2a: FLOOD sense 1a 

b: FLOOD sense 2the tide's ebb and flow 

3a: a smooth uninterrupted movement or progress flow of information 

b: STREAM also: a mass of material which has flowed when molten an old lava flow 

c: the direction of movement or development go with the flow 

4: the quantity that flows in a certain time a gauge that measures fuel flow 

5a: the motion characteristic of fluids 

b: a continuous transfer of energy 

“Flow.” Merriam-Webster.com Dictionary, Merriam-Webster, https://www.merriam-webster.com/dictionary/flow.  

 

Here’s where it gets fun - in the Revit MEP system, the direction that air/fluid/power take does 
not necessarily follow “logical” design thinking. While calculations follow the “motion 
characteristics of fluids” as well as a “continuous transfer of energy”, Revit system flow is based 
on one primary characteristic – flow is always “out” from a source, and “in” to a target. 

Examples include: 

- Airflow at an air terminal is always “in” using preset values for actual air flow and 
pressure loss. 

- Water flow at a pump would be considered “in” at the pump intake and “out” at the 
discharge – but the flow at a tank would be considered “in” when supplied by the pump, 
and “out” when drawn of the tank. 

- A light fixture is also “in” based on “balanced load” with the apparent load, power factor, 
load classification and demand factor associated with the light, while the panel circuit 
properties is always “out” to the devices. 
 

From here we can learn about targets and sources by looking at four families – the air terminal, 
a light, a ball valve and a VAV box. 
 

The Air Terminal 
 
Open a supply air terminal family (such as a Supply Diffuser - Rectangular Face Rectangular 
Neck) by selecting an example and then choosing Edit Family (if the component lives in a Revit 
project). The file is opened and shows the connector, which is indicated by a green circle with a 
directional arrow: 
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Don’t get confused by the arrow – this simply indicates the direction a duct, pipe, conduit or 
cable trey will be drawn based on an automatic or manual layout. Select the connector, and 
review the properties: 
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The key properties to set include: 
 

- Flow Configuration: since all targets determine the flow values, the configuration 
determines whether to use Preset (a specified value), Calculated (accumulated values 
from targets) or System (sum airflow values associated with the duct and/or accessories. 

- Flow Direction: All targets are set to “in”, and all sources are set to “out”. In a few rare 
cases a connector could be considered both a target and/or a source – in this case, you 
can use bidirectional, such as a pump connection, but in most cases, this application is 
rare. 

- System Classification determines the unit values for flow – these items are fixed and 
cannot be edited by a user, but determine the formulas used to perform flow calculation. 
As a personal habit, I use a specific system such as supply air, return air, etc. Ina few 
cases where an air terminal could be used for both, you could potentially use global, but 
for more consistent results these should be assigned. Fitting should only be used 
for…duct fittings, since these are merely “pass-through” components in a system. 

- Loss Method: this establishes the expression of pressure loss values. For targets, a 
specific loss factor can be assigned to a connector, but a source is typically set to none 
since it’s reading flow values with the pressure loss already calculated based on the 
distance, fittings and more. 

 

The Light Fixture 
 

Similar to the air terminal, the light fixture is a great example of a target. The connector offers 
electrical specific values (but no direction arrow, as you would need to place a separate 
conduit/cable tray connector that currently has nothing to do with a circuit). Open the family and 
select the connector to review the properties: 
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Key properties in the light fixture include: 

 

- System Type – there are several options for special systems such as data and 
communication, but for circuits there are two – Power-Balanced and Power-Unbalanced. 
The only time the unbalanced option should be used is with a device such as a motor 
that has three phase loads, where the startup of a unit requires different apparent load 
values. 

- Number of poles determines how the circuit is defined as a single, double or three pole 
circuit. This also defines the number of slots consumed in a panel. 

- Power Factor state is either lagging or leading – set this according to the NEC code 
requirements. 

- Load Classifications control the assigned Demand Factor to a connector. There are 
wide range of classification types, from generic examples such as Lighting, Receptable 
to Continuous loads. Demand factors are determined by load type and code 
requirements. 

- Voltage determines the associated voltage the device can be connected to – in Revit, 
this is a range, so a 120v device can connect between 110v and 130v. Connections to 
other voltage definitions would then be blocked, based on the assigned values, to 
prevent the incorrect voltage being used on a circuit. 

- Apparent load is measured in volt-amperes by default and is always assigned the target 
(similar to the flow value in the air terminal). 

- Power Factor is “the relationship (phase) of current and voltage in AC electrical 
distribution systems”. For most loads this value is measured as 100% when items are 
considered “in phase”, but inductive loads could be 80-90%. This would be indicated by 
a decimal value (i.e., 0.8). 

In both cases, the target connector is what defines the system and circuit, as well as the load 
values and mitigating factors.  

 

The VAV Box 
 

In air system, it is common to have a mechanical equipment component act as an intermediate 
device in a system. In our example, the VAV box is the source – it is what provides and controls 
the flow of air to the air terminals. But it also has other connections, such as a target HVAC 
connection that feeds back to the air handling unit, a target pipe connection when water coils 
are included, and power connections. The first connector to review is the source HVAC 
connection: 
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Note how this is set to Calculated, Out, Supply Air and Not defined. The VAV is simply 
acquiring the data from the air terminals, and the conditions related to the connecting geometry 
of duct will determine the actual pressure loss value. Calculated is what tells the connector to 
gather this information. 

 

The same device also includes the target connection – in most cases when a part has more 
than one connection, one or more could be a target – but only one source connection should 
exist: 
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Note how it is using the same values as the air terminal. 

But how do the flow values translate from one connector to another? If you look closely at the 
settings, the connections are NOT linked. We’ll come back to this conundrum after reviewing 
the valve. 

 

The Ball Valve 
 

Everything we have reviewed so far represents the beginning and end of the system. But there 
a wide variety of components that exist between each, from the connecting geometry of 
duct/pipe/wiring to intermediate devices such as valve. While these items can have an impact 
on sizing and flow calculations, they represent neither a target nor source. Take a look at this 
ball valve: 
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This is a great example of additional uses of connector properties that serve in a “pass-
through” device. While the configuration is still considered a calculated value since it is 
acquiring flow data from a target, its direction is bidirectional to be placed in any direction. The 
loss method is based on a K Coefficient value, with a system classification of global. This 
allows use with all of the fluid-based systems in a Revit model, from domestic cold water to 
condenser water. 

Flow should never be assigned here since it is be acquired – in some rare cases though, if a 
valve represents the end of a line (such as a hose bibb) then it should be set accordingly to use 
a preset, In value with specific flow. 

The most important feature to note are the linked connectors. Connectors are typically linked 
in most pipe and duct accessories, as well as with pipe and duct fittings. Since the valve is 
neither a target in source, you can link connectors to pass the data through the device. But with 
the VAV, since it is always going to be either a target or source, you cannot link the connectors 
as the family part type does not allow this to be used, when flow direction is set to either in or 
out – a requirement of the target in source. 

So how do we transfer this data? That’s next…. 
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Associating and Exposing Connector Data 
 

Most connection values by default are only defined within a family. In order for the data to be 
shared and exposed, it needs to be “associated” with other parameters that can be viewed and 
edited from a project. 

How to Associate a Parameter in a Family 
 

In order for a connector parameter to be editable in a project, it needs to be associated. Start by 
reviewing the VAV box family, and selecting the HVAC supply air connector as shown: 

 

 

From the properties palette, note how several values are greyed out. This indicates the value 
may be obtained from somewhere else. This could be a built-in parameter (such as flow factor, 
loss coefficient) but could also be from an association to another parameter that has been 
created by the user (height, width, flow pressure drop). These are indicated by the “=” sign that 
appears on the icon to the right of the property: 
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Select the icon for the Height parameter – the Associate Family Parameter dialog will appear: 
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The dialog indicates that the parameter being used is a family parameter and based on the 
common > Length type. The name of the associated parameter is SupplyConnectorDepth 
(note: when creating parameters that are used in formulas, it’s a good idea to skip the spaces). 

 

You can select the New icon to create a new parameter to associate with the existing that is 
associated with the connector. But parameters can also be created from the Family Types tool 
and then selected to be associated with a parameter. Cancel to exit the dialog, and open the 
Family Types tool: 
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Note the differences between the parameter names. Some include a (default) notation – this 
indicated that the parameter is instance based, which will be specific to the one “placed” 
instance or example in a project. All others are type based, which will apply to all examples 
placed in a project. Select the SupplyConnectorDepth, and then select the pencil icon to edit 
this parameter: 
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In this instance, the parameter data is displayed as well as the type and settings. This 
parameter is associated with the connector shape and the 3D solid associated with it. Since it is 
defined as parameter and then associated with the connector, it can be edited directly in a 
project. 

 

Leveraging the Association 
 

A dimensional parameter, while important to the creation of the part, typically would not be 
considered critical data that needs to be shared. In the case of our VAV, airflow is a value that 
typically would be used in a schedule, tag or exported to an external database or program. To 
create a parameter that reads the airflow from the source side of the box and transfers it to the 
target side, let’s review this example. 

There are two primary connections – one for the calculated supply airflow connector to 
targets, and a preset value that acts as a target airflow. Select the calculated HVAC source 
connector: 

 

This connector has an association with the SupplyAirFlow parameter. Since we cannot use the 
Link Connectors feature to transfer the airflow value, cancel out of this dialog and select the 
round target HVAC connection. Select the Associate Family Parameter tool to open the 
dialog, and then click New to create a new association: 
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In this example, an existing shared parameter, Airflow Rate, was used as the new parameter. It 
is set as an instance property so the flow can be unique to the connection. Click OK until you 
have closed all dialogs. The parameter is based on the HVAC project units for airflow, so the 
values can be correctly interpreted when calculating duct and system sizes. 

To create the connection, open the Family Types. You can now create a simple formula – use 
the existing SupplyAirFlow parameter as the formula value (use copy and paste for the name, 
as all parameters are CaSe sensitive): 

 

 

By leveraging the associated parameter, the data is now exposed. You can also use formulas to 
manipulate the values as needed to modify and calculate different data results. 
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Sharing MEP Data for System Analysis 

 
We are going to wrap this session up by reviewing options for harvesting and sharing data from 
a systems model. After nearly four decades of industry experience, it’s interesting to see where 
we are going as an industry. While it has taken us this long just to realize the power of 3D 
modeling over 2D drawing, the advent and progression towards digital twins is forcing the 
industry to look at resources such as a common data environment to host information that 
traditionally been segregated by the silos we create. Autodesk Forge and other PaaS (Platform 
as a Service) offerings are beginning to become the end goal of eliminating these silos. 

Enough pontification – let’s get some data out of our project. 

 

Role of the Shared Parameter 
 

As we examined earlier, a shared parameter is used to create data that can be used in 
schedules, tags and exported to external databases. The shared parameter lives in an external 
text file that can be shared with all members of design team as well as with the client – who can 
also provide shared parameters for their end purposes. A shared parameter could be used to 
share electrical data such as Voltage, to owner data such as an asset tag.  

In a family itself, you can use one of two types of parameters: 

- a family parameter, which cannot be used in schedules, tags or exported to a database.  
- a shared parameter, which can be used in schedules, tags or exported to a database. 

Projects include a specific project parameter that can be used in a schedule, but not in a tag. A 
shared parameter can be used to define a project parameter. 

How do you know when to apply each? It’s actually fairly simple. For most dimensional, 
graphical or other conditions where it is not critical to expose the data in schedule, use Family. 
This prevents the data from appearing in a schedule list, but is still available when used to 
control visibility, sizes and more in a project. One key item to note – family parameters can be 
associated with a shared parameter if the data (or values derived from a formula) are needed 
for schedules or data export. 

Shared Parameters which are created as part of a text file are the option to use when the data 
is essential for schedules and tags. Over the years, I have seen projects where users preload 
shared parameters for schedules in a project as project parameters, but this should be avoided 
for generic Revit categories such as mechanical, electrical or specialty equipment unless the 
parameter applies to all examples in that category.  

There are currently no tools or methods to filter these parameters to specific sub-category 
types, such as fans, VAV boxes, air handling units and more under Mechanical Equipment. In 
these cases, the shared parameters should always be created in the family and not the project 
unless they apply to all examples in that category. For example, items like Fan ESP, EWT/LWT 
temperatures related to coils and other specific items belong in the family itself. 

Also, it’s important to be aware that shared parameters are identified in a Revit family or model 
by a GUID number and not the name – so avoid using multiple shared parameter files that 
include different variations of a common parameter such as voltage, number of poles and 
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others. This can lead to duplicate options appearing when attempting to create a schedule, with 
no way of discerning the differences between the two: 

 

The industry is in desperate need of standardization here, but for now, you need to know how to 
leverage the shared parameter data with external resources. 

 

Leveraging Schedules for Data Extraction 
 

There are a variety of schedules we produce for construction documentation, and they can also 
be used to gather data needed for a variety of external uses. Creating text files that contain this 
data, which can be easily read and use by Excel and other applications, can be accomplished 
by building a schedule and exporting it. 

For this example, we are going to look at system data related to circuits. In this example, we 
have created an electrical circuit schedule that allows us to examine circuit properties by 
panel and circuit: 

 

Rather than working through a panel schedule, this version allows us to read the exact same 
data that is included in a panel schedule, expand the fields to review and add calculations to 
help us understand the conditions. Note how the one field for % RATING is Red. In this 
example, we used a formula to convert Apparent Current (a built-in parameter for Revit based 
on current/amps) to a raw number: 
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The next step was to convert another built-in parameter, Rating, that controls the circuit current 
rating in amps, to a raw number: 
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The last step was to create a new parameter that performed the calculation needed to interpret 
the percentage of load that has been applied to the circuit: 

 

 

What we are looking for is the circuit value not to exceed a specific value, such as .8 – this 
represents 80% of the load applied to the circuit. The formatting of the parameter is set to 
appear red when the load exceeds this value: 
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This represents a simple set of calculations and data that can be consumed by an external user.  

Now that it is time to share the data, make sure the project is saved and synchronized.  

Please note that you must have the schedule view current to complete the next step. 

1. From the Home tab, click Export > Reports > Schedule: 
 

 
 

2. You will be prompted to specify a file name – after entering the name, review the 
options:  
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3. Note that since our data includes commas in the formatting (the load names and wire 
types all include them), change the field delimiter to a semi-colon, which is not used in 
the schedule. Click OK to continue.  
 

4. Once the file is created, don’t double-click to open it – instead, from Excel, select 
Open. This will open the text file conversion tools - a key change is to make sure you 
are using the semi-colon as the delimiter for the data: 
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5. Click Finish, and the schedule data will appear: 
 

 
 

This final example image has a little more “dressing” to it for formatting, but the point is that the 
data can easily be extracted to a usable form, that does not require the engineer or other 
consumer to use Revit itself to see the system-based data for the circuit itself from one single 
source. 
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Using Other Resources 
 
While this section provides general information about methods for harvesting data from a Revit 
project, there are a ton of other resources, software and tools that have been developed by third 
parties and individuals, in addition to the Autodesk tools. Here are some links to some of these 
resources: 
 

 Export to ODBC/DB Link 

 Dynamo 

 Forge Data Exchange (BETA) 

 

 

Conclusion 

 
It has been a tremendous journey for the past four decades and see all of the progress that has 
been made in our design tools. As we move forward towards true digital twins, generative 
design and more intelligent and robust set of design tools, understanding these key components 
of systems in Revit can help you reach these goals in a more productive way. Get to know your 
systems – and get ahead of the competition! 


